
New Horizon Map (File Menu)

Create a new horizon map window, using the stored default settings. If the "auto redraw" 
option is turned on, the map will be computed and displayed automatically as soon as the 
window has been created.



New Area Map (File Menu)

Create a new Area map window, using the stored default values. Selecting this option 
displays the Area Map View dialog. If the dialog is exited with the OK button, the map will 
be created at the specified coordinates. If the dialog is exited with the Cancel button, the 
operation is aborted and a new map will not be created.



Open (File Menu)

Read in and display an image file. Selecting this option invokes a standard file selector, 
from which the image file can be selected. The image formats supported by the current 
version of SkyMap are:

GIF Graphics Interchange Format files, both
GIF87a and GIF89a variants.

BMP, DIB, RLE Windows bitmap files.
IMG, IMQ, IBG NASA PDS files.

Close (File Menu)

Close the current window.



Save Defaults (File Menu)

Save the current map settings as the default values to be used for creating a new map of 
the current type. You will be asked to confirm that the settings should be saved.



Preferences (File Menu)

Display the Global Preferences Dialog, to set up global program options.



Zoom In (View Menu)

Zoom in on the map. The map is zoomed around the centre of the image currently visible in
the window.



Zoom Out (View Menu)

Zoom out on the map. The map is zoomed around the centre of the image currently visible 
in the window.



Show (View Menu)

Display the Visible Objects Dialog. This dialog provides a rapid means of controlling the 
visibility of the different types of object which can be displayed on the map.



Select North View

Set the map view to North, preserving the current altitude and field of view.



Select East View

Set the map view to East, preserving the current altitude and field of view.



Select South View

Set the map view to South, preserving the current altitude and field of view.



Select West View

Set the map view to West, preserving the current altitude and field of view.



Toggle Star Label Display

Switch the display of star labels on or off. Star labels are displayed according to the 
settings in the Star Labelling Options dialog.



Toggle Constellation Figure Display

Switch the display of constellation figures on or off. Constellation figures are lines 
connecting the bright stars in a constellation, and can provide a useful way of memorising 
the constellations.



Toggle Constellation Name Display

Switch the display of constellation names on or off.



Toggle Constellation Boundary Display

Switch the display of official IAU constellation boundary lines on or off.



Toggle Comet Display

Switch the display of comets on or off. The comets to be displayed are selected using the 
Comet... item on the Options menu.



Toggle RNGC Object Display

Switch the display of deep sky objects on or off. The type of deep sky objects to be 
displayed are selected using the Comets... item on the Options menu.



Toggle Altitude/Azimuth Grid Display

Switch the altitude/azimuth grid on or off. The way the grid is displayed is controlled using 
the Alt/Az Labels... item on the Options menu.



Toggle Right Ascension/Declination Grid Display

Switch the RA/Dec grid on or off.



Draw Map (View Menu)

If automatic redraw mode is turned off, this option causes an invalid map to be recalculated
using the current settings. The symbol "INV" (Invalid) will be displayed on the status bar 
when the map needs recalculating.

See also:
Auto Redraw



Flip Map Vertically (View Menu)

Invert the map top-to-bottom. This command can be used to correctly align the map 
display with the inversions and reflections of the image introduced by the optics of your 
telescope.



Flip Map Horizontally (View Menu)

Reflect the map left-to-right. This command can be used to correctly align the map display 
with the inversions and reflections of the image introduced by the optics of your telescope.



Set Map Viewpoint (Options Menu)

Set up the viewpoint of the map. Selecting this option displays the Field of View dialog.



Stars (Options Menu)

Display the Stars Dialog. This determines the magnitude of the faintest star which will 
appear on the map, and also controls the size of the star images.



Star Labels (Options Menu)

Display the star labels dialog. This controls which stars on the map will be labelled (if star 
labels are turned on), and also what type of label (proper name, Bayer letter, or Flamsteed 
number) a star is labelled with.



RNGC Options (Options Menu)

Display the RNGC Options Dialog. This controls what type of deep sky objects will be 
displayed on the map (if RNGC object display is turned on).



Comets (Options Menu)

Display the Comet Selection Dialog. This determines which comets in the comet catalogue 
are displayed on the map, and also provides maintenance facilities for the catalogue, 
allowing the user to add, remove and edit comet details.



Alt/Az Labels (Options Menu)

Display the Altitude/Azimuth Label Options Dialog. This determines the way in which the 
altitude and azimuth scales of the Horizon map are labelled.



Screen Colours (Options Menu)

Displays the screen colour editing dialog. This allows the user to edit the colour of the 
various objects appearing on the screen map display. These colour settings are 
automatically saved between runs of the program.



Printer Colours (Options Menu)
Displays the printer colour editing dialog. This allows the user to edit the colour of the 
various objects appearing on a colour printed map. These colour settings are automatically 
saved between runs of the program.



High Precision (Options Menu)

Switches high precision calculation mode on or off. When high precision mode is switched 
on (ie, when a check mark appears alongside the menu), the positions of all objects 
displayed on the map are rigorously corrected for precession, proper motion (in the case of 
stars), aberration, nutation, and refraction. When high precision mode is switched off, 
positions are only corrected for refraction.

The only situation in which high precision mode becomes important is when displaying 
maps for the distant past or future, where precession has an important influence. As a 
rough guide, high precision mode should be switched on for any map drawn for a date 
more than 50 years either side of 2000AD.



Auto Redraw (Options Menu)

Switches "auto redraw" mode on or off. When switched on (ie, when a check mark appears 
alongside the menu item), the map is automatically recalculated following any change 
which necessitates this. If you are running SkyMap on a slow computer - specifically, on a 
computer without a maths co-processor - you may wish to switch this option off to allow 
you to make changes to the map settings more rapidly.

If auto redraw mode is switched off and the map settings change in a way that necessitates
a recalculation, the letters "INV" (short for "Invalid") will appear on the status bar to inform 
you of the situation. Once all required changes have been made, the map can then be 
recalculated using the Draw item on the View menu, or the equivalent tool bar button or 
keyboard shortcut.



Search for a Planet (Search Menu)

Search for a planet, or the Sun or Moon. A dialog box containing the names of the planets 
will be displayed. The action of this command varies slightly with the map type:

On an Area map, the map will be centred on the location of the planet.

On a Horizon map, the map will be centred on the location of the planet if it is currently 
above the horizon using the current location and time settings. If the planet is not currently
visible, a message will be displayed and the current viewpoint left unchanged.



Search for a Constellation (Search Menu)

Search for a constellation. A dialog box containing the names of the constellations will be 
displayed. The action of this command varies slightly with the map type:

On an Area map, the map will be centred on the location of the constellation name.

On a Horizon map, the map will be centred on the location of the constellation name if it is 
currently above the horizon using the current location and time settings. If the constellation
name is not currently visible, a message will be displayed and the current viewpoint left 
unchanged.



Search for a Star by Proper Name (Search Menu)

Search for a star by specifying its "proper name". A proper name is a name such as 
"Polaris", "Betelgeuse", "Aldebaran", etc. Only a few stars on the map will have a proper 
name; mainly the brighter stars.

On a Horizon map, this command will display a dialog box listing all the proper names of 
stars that are currently above the horizon. Selecting a name will centre the map on that 
star.

On an Area map, the command displays a dialog box listing all the proper names in the star
database. Selecting a name will centre the map on that star.



Search for a Star by Bayer Letter (Search Menu)

Search for a star by specifying its Bayer letter. Bayer letters are Greek letters which label 
the brightest stars in a constellation. In the majority of cases, the stars are labelled roughly 
in decreasing order of brightness; the brightest star being "a", the second brightest "b", 
and so on, although there are exceptions to this. The stars of Ursa Major, for example, are 
labelled in sequence along the shape of the "Plough" or "Big Dipper". In some cases, a 
number is added to the letter. The stars forming Orion's "shield", for example, are labelled 
"p1", "p2", etc.

When this command is selected, a dialog box is displayed allowing the entry of a Greek 
letter, a qualifying number, and a constellation. The number zero should always be used 
where no number is required.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Star by Flamsteed Number (Search Menu)

Search for a star by specifying its Flamsteed number. Flamsteed numbers are numbers 
which label the brighter stars in each constellation. Today they are normally used in cases 
where a fairly star does not have a Bayer letter, since they normally extend to a fainter 
magnitude limit than that permitted by the 24 letters of the Greek alphabet used in the 
Bayer labelling scheme.

When this command is selected, a dialog box is displayed allowing the entry of a Flamsteed
number and a constellation.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Star by SAO Catalogue Number (Search Menu)

Search for a star by specifying its SAO catalogue number. This is rarely useful, but is 
supplied for completeness. When this command is selected, a dialog appears allowing the 
entry of an SAO catalogue number.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Deep Sky Object by Popular Name (Search Menu)

Search for a deep sky object by its "popular name". Such names include "Orion Nebula", 
"Whirlpool Galaxy", "Ring Nebula", etc.

Selecting this option displays a dialog box of names. In the case of a Horizon map, the list 
contains the names of all objects currently above the horizon; in the case of an Area map, it
contains all the names in the database. Selecting a name centres the map on the location 
of the object.

Note that the object will not necessarily be visible on the map after this command is used. 
The command simply centres the map on the location of the object - it does not 
automatically display it. You may have to use the RNGC Options... item on the Options 
menu, and possibly the RNGC tool bar button to actually see the object!



Search for a Deep Sky Object by Messier Number (Search Menu)

Search for an object in the Messier catalogue. When selected, a dialog will appear in which 
a Messier catalogue number can be entered. In the case of a Horizon map, the list of 
objects currently above the horizon will be searched for the object; in the case of an Area 
map, the entire database will be searched. If located, the map will be centred on the 
location of the object. Note, however, that:

1. The object will not necessarily be visible on the map after this command is used. The 
command simply centres the map on the location of the object - it does not automatically 
display it. You may have to use the RNGC Options... item on the Options menu, and 
possibly the RNGC tool bar button to actually see the object!

2. The program uses the RNGC database as its data source, and not all Messier objects are 
in the RNGC catalogue. The four "missing" Messier objects are:

M24 A local brightening of the Milky Way.
M25 The open cluster IC 4725
M40 The wide double star Winneke 4
M45 The Pleiades



Search for a Deep Sky Object by RNGC Number (Search Menu)

Search for an object by its RNGC catalogue number. When selected, a dialog will appear in 
which an RNGCr catalogue number can be entered. In the case of a Horizon map, the list of 
objects currently above the horizon will be searched for the object; in the case of an Area 
map, the entire database will be searched. If located, the map will be centred on the 
location of the object.

Note, however, that the object will not necessarily be visible on the map after this 
command is used. The command simply centres the map on the location of the object - it 
does not automatically display it. You may have to use the RNGC Options... item on the 
Options menu, and possibly the RNGC tool bar button to actually see the object!



Search for a Comet (Search Menu)

Search for a comet on the map. When this command is selected, a dialog box with a list of 
comets will be displayed. In the case of an Area map, the list will contain the names of all 
the currently active comets; for a Horizon map it will contain those active comets which are
currently above the horizon.

Selecting a name from the list will centre the map on the comet's location.



Setting the Date and Time of Observation (Options Menu)

To set the time and date for which the map is drawn, select the Time... item from the 
Options menu. The Observation Time Dialog will be displayed.
For the horizon map, changing the time of observation obviously alters the map view 
completely. For the area map, the main effect is to alter the positions of objects in the solar 
system.

Shortcut:        

Notes:

1. The observation time is taken to be in the observer's local time zone. SkyMap 
converts the entered time to UTC by applying the corrections for the observer's time 
zone and (if applicable) for daylight saving time.

2. If the date is on or after 0h on October 15th, 1582, it is assumed to be in the 
Gregorian calendar. If before this, the Julian calendar is used.



Setting the Location of the Observer (Options Menu)

To set up the position of the observer, together with associated information such as time 
zone information, weather conditions, etc, select the Observer... item from the Options 
menu. The Observation Location Dialog will be displayed.
For the horizon map, changing the observer's location obviously alters the map view 
completely. For the area map, the only effect is to slightly alter the apparent positions of 
objects in the solar system, most notably the Moon, due to the effects of parallax.

Shortcut:        



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
pictures you viewed.    Choose the number that corresponds with the picture you want to 
open.



Exit (File Menu)

Use this command to end your SkyMap session.    You can also use the Close command on 
the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in SkyMap.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in SkyMap,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

To obtain information about any button on the Toolbar, select context sensitive help mode 
by either clicking the help button:

or pressing SHIFT+F1, then click the button you require help on.



Status Bar (View Menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state.
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the SkyMap window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade (Window Menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile (Window Menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal (Window Menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical (Window Menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window Menu)

SkyMap displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    
Choose a document from this list to make its window active.    



Help Index (Help Menu)

Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using SkyMap and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help (Help Menu)

Use this command for instructions about using Help.



About SkyMap (Help Menu)

Use this command to display the copyright notice and version number of your copy of 
SkyMap.



Context Help 

Use the Context Help command to obtain help on some portion of SkyMap.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the SkyMap window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Scroll Bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size (System Menu)

Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move (Control Menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize (Application Control Menu)

Use this command to reduce the SkyMap window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize (System Menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window (Document Control Menu)

Use this command to switch to the next open document window.    SkyMap determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window (Document Control Menu)

Use this command to switch to the previous open document window.    SkyMap determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close (Control Menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore (Control Menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to (Application Control Menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Print (File Menu)

Use this command to print a document.      This command presents a Print dialog box, where
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Dialog

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that SkyMap is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup (File Menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup Dialog

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



The Horizon Map

A horizon map shows a view of the sky as seen by an observer for a selected place and 
time. Its main use is simply to see "what's up" at any desired time. Once the map has been 
calculated, the viewpoint can quickly be moved to display a view of any part of the visible 
sky.
Although all the information in SkyMap's databases can be displayed on a horizon map, it 
isn't a good idea to display faint stars, deep-sky objects, etc - the map just gets too 
crowded and takes too long to draw! The recommended way of working is to use the 
horizon map to get a general picture of what's visible, then to draw a detailed Area map for
a specific part of the sky that you wish to observe.
For more information about drawing and using a horizon map, select one of the topics 
below:

Creating and Setting up a Horizon Map
Changing the Viewpoint
Displaying Objects on a Map
Identifying Objects on a Map 
Searching for Objects on a Map
Drawing an Area Map
Saving the Map Settings



Identifying Objects on a Map

To identify any object on a map:

1. Position the tip of the mouse pointer over the object, then press the right mouse 
button. A "pop-up" menu will appear underneath the mouse pointer. The exact 
number and wording of the items on the menu will depend on the situation, but there
should be a menu item referring to the object you clicked on.

2. Select the item with the left mouse button, and a dialog box containing information 
about the object will be displayed.

For further help on the information displayed in the object description dialog box, press F1 
while the dialog is visible.



Drawing an Area Map from a Horizon Map

To draw an area map showing a detailed view of a part of the sky visible on a horizon map:

1. Position the mouse pointer over the point on the horizon map that you want to 
appear in the centre of the area map.

2. Press the right mouse button. A "pop-up" menu will appear underneath the mouse 
pointer.

3. Select the Area Map... item from the pop-up menu with the left mouse button. A 
dialog box will appear showing the right ascension and declination of the point you 
clicked on, with the caret in the "Field of View" box. Enter the required field of view 
for the area map, and click the OK button (or just press Enter). The map will be 
drawn.



Changing the Horizon Map Viewpoint

Once the horizon map has been displayed for the first time, the viewpoint can easily be 
changed to view any part of the visible sky. There are several ways to do this:

1. Use the buttons on the tool bar to change the view to North, East, South, or West. 
This leaves the central altitude and field of view unchanged.

2. Position the mouse pointer over the location you wish to be the centre of the new 
map. Press the right mouse button. Select Centre from the pop-up menu which appears.

3. From the Options menu select Field of View. Enter the central altitude and azimuth
and the required field of view into the dialog box which appears.

Shortcut:        



Creating and Setting Up a Horizon Map

To create a new horizon map, select New Horizon Map from the File menu. A new map 
window will appear, and the default map settings will be loaded. The time and date will be 
read from the computer's clock. Once the map has been created, you will probably wish to 
configure it. This involves several steps:

Setting the Date and Time of Observation 
Setting the Location of the Observer
See also:
Saving the Map Settings



Displaying Objects on the Horizon Map

A wide variety of objects can be displayed on a horizon map. These include:

Stars
Planets
Comets
Deep sky objects (galaxies, star clusters, and nebulae)
Constellation boundaries, figures, and names
A grid of altitude and azimuth lines

The objects which appear on the map are controlled in two ways:

1. The items on the Options menu set the display options for each type of object. For 
example, the Star Labels... item controls the way in which stars are labelled; the 
Comets... item allows the user to select which comets will be displayed. To get 
specific help on these options, select the item and then press F1.

2. The Show... item on the View menu (and the equivalent buttons on the tool bar) 
allows the user to select which items are shown on the map. A huge quantity of 
information is available, and having it all displayed at once would be very confusing. 
This menu item provides a rapid way to select exactly the desired items.

Shortcut:        



Saving the Horizon Map Settings

When all the horizon map options have been set up to your satisfaction they can be saved 
for use as the default settings for all subsequent horizon maps. To do this:

1. From the File menu select Save Defaults.... A dialog box will appear asking for 
confirmation of the operation.

2. Click on the Yes button, or just press Enter. The current map settings will then be 
saved.



Searching for Objects on a Horizon Map

To search for specific objects on a horizon map use the items on the Search menu. Note 
that you can only search for objects which are currently above the horizon.

See also:
Searching for a Planet
Searching for a Constellation
Searching for a Star by Proper Name
Searching for a Star by Bayer Letter
Searching for a Star by Flamsteed Number
Searching for a Star by SAO Number
Searching for a Deep Sky Object by Popular Name
Searching for a Deep Sky Object by Messier Number
Searching for a Deep Sky Object by RNGC Number
Searching for a Comet



Observation Location Dialog

This dialog contains information about the observer. The information can be divided into 
several categories:

Position Information
The latitude and longitude of the observer, in degrees, minutes and seconds. This 
information can be obtained from a local map.

Time Zone Information
The observer's time zone, and whether or not daylight saving time is currently in effect. 
Note that the time information is entered in minutes (not hours) ahead of or behind UT 
(Greenwich Mean Time).

Weather Information
The observer's local weather conditions. This information is used to calculate the effects of 
refraction. Unless you live in a very extreme climate, or desire the ultimate in accuracy 
when calculating the apparent altitude of an object, it is quite acceptable to leave these 
values at their default settings.

Location List
The listbox at the bottom of the dialog can be used to select a location. If a name is 
selected from a list, the appropriate latitude, longitude and time zone information are 
automatically filled in.
You can add your own entries to the location list by editing the ASCII file LOCATION.SKY with
any convenient editor - the DOS "edit" editor is fine for this purpose. Each line in the file 
consists of four items, separated with a space. These items are, in order:

Latitude in degrees, + if North, - if South.
Longitude in degrees, + if West, - if East.
Time difference from GMT in hours. + if behind GMT, - if ahead of GMT
Name to appear in the list.

An example line from the file is:
47.60 122.33 8 USA: Seattle WA

If you add the names of any large towns or cities to the list, please send me the information
and I'll incorporate it into the next release of SkyMap.



Observation Time Dialog

This dialog specifies the date and time of observation. Note that the time is taken to be in 
the observer's local time zone, possibly corrected for the effect of daylight saving time, as 
specified in the Observation Location Dialog.

The Now button sets the date and time from the computer's clock.
The Midnight button leaves the date unchanged, but sets the time to 00:00:00.

Note that any date on or after October 15th, 1582, is assumed to be in the Gregorian 
calendar. Any date before this uses the Julian calendar.



Horizon Map View Dialog

This dialog defines the centre and field of view of the horizon map.

Map Centre
The altitude and azimuth of the centre of the map.
Field of View
The vertical field of view of the map. in degrees.



About SkyMap Dialog

This dialog displays copyright and version information about SkyMap. When requesting 
help, please always quote the version number shown. The picture is the spiral galaxy M74 
in Pisces.



Stars Dialog

This dialog controls both the "limiting magnitude" of stars on the map (ie, the faintest star 
which is drawn), and also the way in which the stars are drawn.

Limiting Magnitude
The magnitude of the faintest star to be drawn on the map.

Image Display
This section of the dialog allows you to control the sizes of the "dots" used to represent the 
stars on the map.
The first line shows the size of the largest star image which will be drawn, and the 
magnitude it corresponds to. Any star brighter than the magnitude shown will be displayed 
using this dot size.
The second line shows the size of the smallest star image which will be drawn, and the 
magnitude it corresponds to. Any star fainter than the magnitude shown will be displayed 
using this dot size.
A star whose magnitude falls between these two limits (as the majority should do) will be 
drawn with a dot whose diameter is inversely proportional to the magnitude.



Star Label Options Dialog

This dialog allows you to specify which labels are used when star labelling is switched on.

Label Options
This group of check boxes specifies which label will be drawn for a star. The options are:

Proper Names, eg "Rigel".
Bayer Letters, eg "a".
Flamsteed Numbers, eg "31".

When labelling a star, this list is scanned from top to bottom. The star is labelled using the 
first existing label which corresponds to a checked option. Eg, if both the "Proper Names" 
and the "Bayer Letters" options are checked, a star which has both a proper name and a 
Bayer letter will be labelled with its proper name; a star with only a Bayer letter will be 
labelled with the letter.

Magnitude Filter
These radio buttons allow you to select whether all stars on the map are labelled, or only 
those stars above a specified magnitude.



Altitude/Azimuth Label Options Dialog

This dialog controls the way the altitude/azimuth grid is drawn, if it is switched on.

Azimuth Label Options:

Label with:
These radio buttons determine whether azimuth is labelled using compass points (eg, "N", 
"NE"), or azimuth numbers (eg 180°).
Azimuth Interval:
If the azimuth axis of the map is being labelled with azimuth numbers, these radio buttons 
allow you to either specify how far apart the lines are drawn, or to allow SkyMap to 
determine the interval automatically.
Compass Interval:
If the azimuth axis of the map is being labelled with compass points, these radio buttons 
allow you to either specify how far apart the lines are drawn, or to allow SkyMap to 
determine the interval automatically.
Draw Azimuth Lines:
Specifies whether the map has lines of azimuth drawn, or simply labelled points along the 
horizon line.

Altitude Label Options

Label with:
These radio buttons determine whether lines of altitude are drawn across the map, or 
simply "tick marks" down the centre of the map.
Altitude Interval:
These radio buttons allow you to either enter an altitude labelling interval manually, or 
allow SkyMap to decide the interval automatically.



Colour Settings Dialog

This dialog allows the colour of each component of the map to be set. There are two ways 
to edit an item:

1. Double click the mouse on the name of the item.
2. Click on the name of the item, then press the Edit... button.

In either case, a colour selector dialog will be displayed, allowing the colour of the item to 
be set. When all colours are set to your satisfaction, press the OK button, and all maps will 
be redrawn with the new colour scheme.

Notes:

1. Colour settings are global and apply to all maps. Changing the colour settings from 
any map alters them for all maps.

2. Colour settings are automatically saved between runs of the program.



Global Preferences Dialog

This dialog sets global application options. The set options are automatically stored when 
the dialog is exited.

Maximize application window:
If this option is checked, SkyMap will maximize itself - ie use the whole screen - when run 
on subsequent occasions. If the option is not checked, the program will run as a normal 
sized window.
Maximize new map window:
If this option is checked, a new map window will be created in a maximized state - ie, using 
the whole of SkyMap's "workspace".
Image File Location:
The directory in which SkyMap will look for image files. Refer to the images section for more
information.
Startup Map Options:
Specifies what type of map, if any,    is created automatically when the program is run.



RNGC Options Dialog

This dialog determines which deep sky objects will appear on the map (if display of RNGC 
objects is currently switched on).

Object Selection
These radio buttons control whether the whole of the RNGC catalogue is used as the data 
source, or only the Messier objects in the RNGC catalogue.
Object Types
These check boxes allow you to select which types of object are displayed. If the "All 
Objects" box is checked, all types of object will be displayed. If "All Objects" is not checked, 
then the remaining boxes in this section of the dialog allow you to control the specific types
of object displayed.
Magnitude Limit
These radio buttons allow you to control whether all objects matching the type selection 
are displayed, or only those objects brighter than a specified magnitude.
Label Objects
If checked, deep sky objects will be labelled with their Messier or RNGC catalogue number. 
If no checked, only a symbol will be drawn on the map.



Print Options Dialog

This dialog sets the options used when printing a map.

Colour
These radio buttons select whether a colour or black and white map is printed. If the colour 
option is selected, the printer colour options are used when printing the map; if the black 
and white option is selected, all objects are printed in black.
Note that the colour option can successfully be used to print a "grey scale" map on a black 
and white printer. The way that colours are translated to shades of grey will vary with the 
printer, and some experimentation will be required to produce a good result. This can 
produce excellent results on a PostScript laser printer; the results on a 9-pin dot matrix 
printer are not quite so good!

Show Map Key
This check box controls whether or not a key is displayed at the bottom of a printed map.



Find Planet Dialog

This dialog allows you to search for a planet, or the Sun or Moon. Select from the list the 
name of the object you wish to find, and press OK.



Find Constellation Dialog

This dialog allows you to search for a constellation. Select from the list the name of the 
constellation you wish to find, and press OK.



Find Star by SAO Number Dialog

This dialog allows you to search for a star by its number in the SAO Star Catalog. Enter the 
catalog number in the dialog, and press OK.



Find Star by Proper Name Dialog

This dialog allows you to search for a star by its "proper name". Select from the list the 
name of the star you wish to search for, and press OK.
Note that, in the case of a Horizon map, the list only contains the names of stars currently 
above the horizon.



Find Star by Bayer Letter Dialog

This dialog allows you to search for a star by its Bayer letter. Enter the letter, optionally a 
qualifying number, and a constellation, then press OK.



Find Star by Flamsteed Number Dialog

This dialog allows you to search for a star by its Flamsteed number. Enter a number and a 
constellation, then press OK.



Find Object by Popular Name Dialog

This dialog allows you to locate a deep sky object by its "popular name" (such as "Whirlpool
Galaxy", for example). Select from the list the name of the object you wish to find, and 
press OK.
Note that, for a horizon map, only the names of those objects currently above the horizon 
will be displayed.



Find Comet Dialog

This dialog allows you to search for a comet. Select from the list the name of the comet you
wish to locate, and press OK.
Note that, for a horizon map, only the names of those comets currently above the horizon 
will be displayed.



Find Messier Object Dialog

This dialog allows you to search for a Messier object. Enter the number of the Messier 
object you wish to locate and press OK.



Find RNGC Object Dialog

This dialog allows you to search for any object in the RNGC catalogue. Enter the number of 
the object you wish to locate and press OK.



Comet Selection Options Dialog

SkyMap maintains a catalogue of comets in the data file COMET.SKY. Since comets are 
typically only visible for a few months either side of their perihelion passage (the point at 
which they are closest to the Sun), you will normally only want to display the positions of a 
few comets at any one time. This dialog allows you to select which comets from the 
catalogue are "active" - ie, will have their position calculated - and also provides facilities 
for maintaining the comet catalogue.
Most of the dialog is occupied by two listboxes:
Known Comets
This is the list of all the comets in the catalogue.
Active Comets
This is the list of comets whose positions will be calculated by SkyMap for the current map.

Selecting Comets for Display
To add a comet to the Active list, highlight its name in the Known list, and click the 
Add>> button. The name of the comet will appear in the Known list.
To remove a comet from the Active list, highlight its name in the list, and click the 
<<Remove button. The name of the comet will disappear from the Active list.
Note that although the name of any comet in the catalogue can be added to the Active 
list, only those comets less than a year either side of perihelion passage will actually be 
displayed on the map. This is due to problems in computing the position of a comet in a 
near-parabolic orbit a long way from perihelion.

Maintaining the Comet Catalogue
The buttons in the Catalogue section of the dialog allow the user to maintain the 
catalogue. The available options are:
Add...
Add a new comet to the catalogue. When this button is pressed, the Comet Orbit Dialog is 
displayed, allowing the user to enter information about the orbit of the new comet.
Edit...
Edit the orbit of the comet whose name is currently highlighted in the Known comets list. 
When this button is pressed, the Comet Orbit Dialog dialog is displayed.
Delete
Delete from the catalogue the comet whose name is currently highlighted in the Known 
comets list. You will be asked for confirmation before the comet is deleted.



Comet Orbit Dialog

This dialog allows information about a comet to be entered or edited. Information contained
in the dialog is described below. The orbital elements should all be referred to epoch 
J2000.0.

Name:
The name of the comet. Up to 31 characters can be entered. A short period comet (one 
with an orbital period less than 200 years) has a name beginning with "P/".
Image:
The name of a file containing a picture of the comet. Only a file name should be entered 
here - the file is assumed to be located in the image file directory specified in the Global 
Preferences Dialog.
T:
The date of perihelion passage of the comet. The time scale used for this is Terrestrial 
Dynamical Time (TDT).
q:
The distance of the comet from the Sun at the time of perihelion passage, in astronomical 
units (AU).
e:
The eccentricity of the comet's orbit. An eccentricity of 0.0 means that the orbit is circular, 
whilst a value of 1.0 indicates a parabola. The majority of comets have an eccentricity 
between 0 and 1.
w:
The argument of perihelion, in degrees.
W:
The longitude of the ascending node of the orbit, in degrees.
i:
The inclination of the orbit, in degrees.
Magnitude Parameters:
These numbers (H and G) are used to calculate the magnitude of the comet given its 
distance from the Earth and Sun.



Star Information Dialog

This dialog displays information about a star. The information displayed will differ from star 
to star, but could include the following:

SAO Catalog Number
The number of the star in the SAO catalog is displayed in the dialog's title bar.
Constellation
The name of the constellation containing the star.
Proper Name
A name, such as "Rigel", by which the star is commonly known.
Bayer Letter
The Bayer identification of the star in the constellation, such as "b Orionis".
Flamsteed Number
The Flamsteed identification of the star in the constellation, such as "19 Orionis".
Magnitude
The visual magnitude of the star.
RA, Dec
The star's right ascension and declination, for the equinox and ecliptic of date. This position
includes all position corrections except refraction.
Alt, Az
The star's apparent altitude and azimuth. This position includes the effects of refraction.



Planet Information Dialog

This dialog displays information about a planet. Several "pages" of information are 
available, and are selected using the group of radio buttons on the right side of the dialog. 
The information available is described below:

Local Information
This page displays information about the planet which varies according to the observer's 
location. The information available is:
Altitude
The apparent altitude of the planet, including the effects of refraction.
Azimuth
The apparent azimuth of the planet.

Geocentric Information
This page displays information about the planet which is independent of the location of the 
observer. The items displayed are:
Right Ascension, Declination
The apparent geocentric right ascension and declination of the planet for the equinox and 
ecliptic of date.
Constellation
The name of the constellation the planet is currently in.
True Distance
The geometric distance between the planet and the Earth. For all objects except the Moon 
the figure is expressed to high accuracy in AU, and a rounded figure in Km is also given. For
the Moon, the accurate distance in Km is given.

Heliocentric Information
This page displays information about the planet relative to the Sun. The items displayed 
are:
Ecliptic Longitude
The ecliptic longitude of the planet, for the mean equinox and ecliptic of date.
Ecliptic Latitude
The ecliptic latitude of the planet, for the mean equinox and ecliptic of date.
Radius Vector
The distance of the planet from the Sun. The distance is given to high accuracy in AU, and 
a rounded figure in Km is also given.

Physical Information



This page displays physical information about the planet. The items available are:
Magnitude
The apparent magnitude of the planet. Note that, in the case of Saturn, this figure does not 
take any account of the illumination of the ring system, so the planet will be brighter than 
the displayed figure.
Phase
The phase of the planet. This corresponds to the fraction of the planet's disk which is 
illuminated by the Sun.
Equatorial Diameter
The equatorial diameter of the planet's apparent disk, in seconds of arc.
Polar Diameter
The polar diameter of the planet's apparent disk, in seconds of arc. If this is not given, the 
planet's disk is assumed to be circular.
Phase Angle
The angular separation between the Sun and the Earth, as seen from the planet. This is 
simply an alternative method of expressing the phase of the planet.
Elongation
The angular separation between the planet and the Sun. Obviously, a small elongation 
indicated that the planet can only be observed shortly before sunrise or after sunset.
Light Time
The length of time it takes for light to travel from the planet to the Earth at the time of 
observation. This is a measure of how "old" the image of the planet we see actually is. Eg, if
the light time of Saturn is 1h 25m, we are actually Saturn as it was 1h 25m ago (and, of 
course, in the location it occupied at that time).



RNGC Information Dialog

This dialog displays information about an RNGC object. The exact information displayed will
vary from object to object, but could include the following:

Name
The dialog title bar will contain the "primary" name of the object. This will either be the 
Messier catalogue number (if the object is a Messier object), or the RNGC catalogue 
number.
RNGC Number
If information about a Messier object is being displayed, this field displays the equivalent 
RNGC number.
Popular Name
The "popular name" of the object, if it has one. This is a name such as "Ring Nebula", or 
"Whirlpool Galaxy".
Type of Object
A description of the type of object. It should be noted, however, that the RNGC was 
compiled well over a century ago, and not all the object classifications are accurate. For 
example, the Crab Nebula is described as a "planetary nebula", although we now know it to
be a supernova remnant.
Description
The coded description of the object, as described by Dreyer in the RNGC. This brief 
description contains a great deal of useful information and, although, cryptic looking, is not 
hard to decypher with practice.
Constellation
The name of the constellation containing the object.
RA, Dec
The right ascension and declination of the object, for the mean equinox and ecliptic of date.



Comet Information Dialog

This dialog displays information about a comet. The items displayed are as follows:

Name
The name of the comet.
Magnitude
The visual magnitude of the comet. Note that this is only a very approximate figure - the 
magnitude of a comet is notoriously difficult to predict! Note also that comets are normally 
diffuse objects, and the magnitude refers to the total brightness of the comet - in order to 
see a 10th magnitude comet it will probably be necessary to be able to see 13th magnitude
stars in the same field!
Elongation
The angular separation between the comet and the Sun, in degrees.
Distance
The distance of the comet from the Earth, in both AU and Km.
Radius Vector
The distance of the comet from the Sun, in both AU and Km.
Constellation
The constellation the comet is in.
RA, Dec
The apparent right ascension and declination of the comet for the mean equinox and 
ecliptic of date.
Alt, Az
The apparent altitude and azimuth of the comet.



Area Map View Dialog

This dialog sets the centre and the field of view of the area map.

Map Centre
The right ascension and declination of the centre of the map.
Field of View
The top-to-bottom field of view of the map, in degrees.



Visible Objects Dialog

This dialog provides a rapid way of selecting the objects to be displayed on the map. Each 
type of object has a check box on the dialog. Check the boxes corresponding to those 
objects you wish to display.
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Using the Help System Effectively

This help system contains the complete documentation for SkyMap. The contents page 
contains items of general interest, which can be reached from any point in the system by 
pressing the Contents button.
Unlike a printed manual, this help system is not designed to be read in isolation. It is very 
much an interactive system, and is intended to be used in conjunction with the SkyMap 
program itself. Several ways of accessing help information are described below:

Help on using a map
To display help information about using a particular type of map, press the F1 key whilst 
the map is displayed. A page of general information will be displayed, together with a list of
related topics which may be of interest.

Help for a menu item or tool bar button
As you move the mouse pointer over a menu item or tool bar button, a brief description of 
the item will appear on the status bar at the bottom of the screen. To obtain a more 
extensive description of the item, press the context sensitive help button (or the keyboard 
equivalent, which is SHIFT+F1):

The mouse pointer will change to an arrow and question mark. Now, simply click the mouse
over any menu item or button and a help screen will be displayed describing the use of that
command or button.

Help for a dialog box
To display a help screen for a dialog box, press the F1 key whilst the dialog box is on the 
screen.



Registering SkyMap

SkyMap is not free software; it is shareware and, as such, you must pay for it if you find it 
useful after a trial period which is not to exceed 30 days. The shareware concept is based 
on trust and I trust you to pay for this program if you are using it. In exchange for 
registering the program you will receive:

1. A registered copy of the latest version of SkyMap.
2. A much larger star database containing 88,000 stars to magnitude 8.5, compared to 

the 15,925 stars to magnitude 7 that this evaluation version contains. The complete 
SAO star catalogue of 259,000 stars to magnitude 9.5 may be purchased as an 
optional extra.

3. A expanded help system containing additional information and sheet shots of all the 
dialogs.

4. Unlimited lifetime support, and a lifetime guarantee of a full refund of your money if 
you ever encounter a bug in SkyMap which renders the program unusable, and which
we are unable to fix.

5. The right to purchase upgrades to future registered versions of SkyMap for a reduced 
price.

For complete information about registering SkyMap please see the separate registration 
form included with the SkyMap package.

See also:

ASP Ombudsman Statement



ASP Ombudsman Statement

This program is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536.



What is Shareware?

Shareware distribution gives users a chance to try software before buying it. If you try a 
shareware program and continue using it, you are expected to register. Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy. And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee
-- if you don't use the product, you don't pay for it!



Contacting the Author

If you have any suggestions about ways in which SkyMap could be improved (and I'm sure 
there are many!), or you have and questions you'd like answered, feel free to contact the 
author by any of the following methods:

Electronic mail
I can be contacted at either of the following addresses:

CompuServe: 100113,1140
Internet: chris@chrism.demon.co.uk

Post
You can send me a letter at the following address:

Chris Marriott
9, Severn Road
Culcheth
Cheshire WA3 5ED
UK

Support in the USA and Canada
SkyMap is exclusively distributed in the United States and Canada by:

Shareable Software International Inc
PO Box 240357
Apple Valley MN 55124
USA

If you have any questions about the software, you may contact SSI at this address or by 
phone, fax or e-mail at:

Phone: 612-322 5868
FAX: 612-322 5871
Orderline 800-622 2793
CompuServe: 76226,2652
Internet: 76226.2652@compuserve.com



Introduction
SkyMap is a "Planetarium" program for Microsoft Windows version 3.1 or later.    It will 
display a map of the sky as seen from any point on Earth for any date between 4000BC and
8000AD.    Two different types of map can be drawn - a "Horizon" map showing the 
observer's local horizon, and a "Sky Area" map showing a detailed view of a small area of 
the sky.    You can get information about any object displayed on the map by simply pointing
at the object with the mouse and clicking the button.    The display of additional 
information, such as constellation figures or star labels can be switched on and off with a 
click of the mouse button, making it easy to see exactly what you want without being 
overwhelmed by unwanted information.    When you have the map exactly as you want it, 
you can print it on any printer supported by Windows, in either black and white or colour.
SkyMap can also display photographic images, supplied in the form of GIF or Windows 
bitmap files.      Thousands of such images are freely available on bulletin boards and 
commercial information systems such as CompuServe.    This allows you to build up your 
own personal library of astronomical photographs which, coupled with the map displays, 
really helps to bring the sky to life!
There are a number of planetarium programs available today.    Unlike some of these, 
SkyMap makes no claims of blinding calculation speeds.    Instead, what SkyMap 
concentrates on is accuracy.    When writing SkyMap I've used the most accurate methods 
available to me for all the calculations.    This accuracy makes SkyMap equally suited for 
both the novice astronomer who just wants to know "what's that bright object up there?" 
and the serious amateur or professional astronomer who wants a detailed "finder chart" for 
a faint galaxy.
SkyMap carries out its calculations in as efficient as manner as possible, but it never 
compromises accuracy for the sake of speed.    An increase in speed can always be 
achieved by using a faster computer!    Having said all that, the speed is still reasonable; on
the author's 33MHz 486-based PC for example, the horizon map, with default settings, is 
computed and drawn in about 5 seconds.
Whilst developing SkyMap I've received the help and encouragement of a number of 
people.    I'd especially like to thank David Webber for many useful suggestions and help 
with the mathematical problems I encountered, and Steve Moshier for generously 
consenting to allow me to use many of his coding ideas for various astronomical 
calculations.    I'd also like to thank my "beta testers" - Lenny Abbey, Scott Miller and 
especially Andy Steere for making many helpful suggestions without which SkyMap would 
not be nearly as good as program as it currently is, Finally, I'd like to thank Jean Meeus for 
writing the book "Astronomical Algorithms" (Willman-Bell, 1991), without which this 
program could never have existed.

Chris Marriott
27th December 1993



Data Sources and Precision

The sources of the data used by SkyMap are as follows:

Stars
Planets and Sun
Moon
RNGC Objects
Time Corrections



Stars

Smithsonian Astrophysical Observatory (SAO) star catalog,    (SAO Staff, 1966), 1990 
machine readable version, as supplied on NASA's National Space Science Data Center's 
"Selected Astronomical Catalogs, Volume 1" CD-ROM.

The SAO star catalog is a catalog of 258,997 stars to epoch J2000.0, and is reasonably 
complete down to magnitude 9.5 or so.    The star database supplied with the shareware 
version of SkyMap contains all the stars from the SAO catalog down to magnitude 7 - a total
of 15,925 stars.    Larger databases, up to and including the full SAO catalog,    are supplied 
to registered users of SkyMap - refer to the separate registration form for details.

SkyMap rigorously reduces star positions from mean to apparent place.    The following 
corrections are applied:

Precession
Proper Motion
Nutation
Aberration

In the case of the Horizon Map, the apparent place is used to compute the local altitude 
and azimuth of the star, and the altitude is then corrected for the effects of refraction.



Planets and Sun

The positions of the Sun, and the planets Mercury to Neptune are computed using a subset 
of    Bretagnon and Francou's VSOP87 planetary theory, as described in the book 
"Astronomical Algorithms", by Jean Meeus (Willman-Bell, 1991).

Spot checks against recent editions of the "Astronomical Almanac" indicate that the mean 
error in the computed positions of the planets is under half a second of arc, with peak 
errors of about one arc second.    For comparison, the apparent diameter of the planet 
Neptune is about 2", whilst that of Jupiter is typically 35".



Moon

The position of the moon is computed from the ELP 2000-85 lunar theory (Chapront-Touzé 
and Chapront, 1988), which in turn is fitted to the DE200/LE200 numerical integration of 
the Jet Propulsion Laboratory (Standish, 1981).

Spot checks against the "Astronomical Almanac" again indicate that the mean error in the 
computed position of the Moon is about half an arc second, with peak errors around one arc
second.



RNGC Objects

For non-stellar objects, SkyMap uses the machine-readable version of the "Revised New 
General Catalog of Non-stellar Astronomical Objects" (Sulentic and Tifft, 1973), or RNGC.    
This is a modern, revised and expanded version of the "New General Catalogue of Nebulae 
and Clusters of Stars" (Dreyer 1888).



Time Corrections

Because of the irregularities in the Earth's rotation, the theories of motion of astronomical 
bodies do not use Universal Time (GMT), but a uniform timescale called Terrestrial 
Dynamical Time (TDT).    SkyMap uses TDT internally for all its calculation of planetary 
positions, etc, but obviously the user specifies the time for which a map is required in UTC 
(or rather, in local time, which is converted to UTC).

The difference between TDT and UT is called "delta T", and currently has a value of 
approximately 1 minute.    It is currently increasing at a rate of somewhat less than 1 
second per year.    The problem is that the value of delta T can only be determined 
historically (typically by analyzing the motion of the Moon), and current and future values 
can only be estimated, whilst values for the distant past (before the advent of modern 
astronomy) are uncertain to the order of many minutes.

What this means in practice is that although the time of a total solar eclipse in the year 
1500BC could be computed to a precision of a fraction of a second in TDT, the actual time 
in UT that the eclipse occurs (hence the places on Earth from which it is visible) will be 
uncertain to within several minutes.

The "Astronomical Almanac" lists the values of delta T for every year from 1620 onwards 
(currently up to 1993), and provides estimates of its value for the current time.    SkyMap 
has all this data stored, and interpolates or extrapolates in this table to find values of delta 
T for dates between 1620 and 2000.

For dates beyond the year 2000, an estimate of delta T is made using the method of 
L V Morrison and F R Stephenson, "Sun and Planetary System" vol 96,73 eds. W Fricke, 
G Teleki, Reidel, Dordrecht (1982).

For dates prior to 1620, an estimate is made using the method of    F R Stephenson and 
M A Houlden, "Atlas of Historical Eclipse Maps", Cambridge University Press (1986).    They 
estimate the uncertainty to be 15 minutes at 1500BC.



Dedication

Respectfully dedicated to the memory of:

Francis R Scobee
Michael J Smith

Ellison S Onizuka
Judith A Resnick
Ronald E McNair
Gregory Jarvis

S Christa McAuliffe

the crew of Challenger flight STS 51-L, 28th January 1986
and to all who have lived - and died - for The Dream.

"Oh, I have slipped the surly bonds of earth,
And danced the skies on laughter-silvered wings;

Sunward I've climbed and joined the tumbling mirth
Of sun-split clouds -- and done a hundred things

You have not dreamed of -- wheeled and soared and swung
High in the sunlit silence. Hov'ring there,

I've chased the shouting wind along and flung
My eager craft through footless halls of air.

Up, up the long, delirious, burning blue
I've topped the wind-swept heights with easy grace,

Where never lark, or even eagle, flew;
And, while with silent, lifting mind I've trod
The high, untrespassed sanctity of space,

Put out my hand, and touched the face of God."

"High Flight"      John G Magee Jr



The Area Map

The area map displays a detailed view of a small area of the sky on a grid of right ascension
and declination. Its main use is as a "finder chart" for observing a specific part of the sky.
For more information about drawing and using an area map, select one of the topics below:

Creating and Setting Up an Area Map
Displaying Objects on a Map
Identifying Objects on a Map
Searching for Objects on a Map
Saving the Map Settings



Creating and Setting Up an Area Map

An area map can be created in one of two ways:

1. Select New Area Map from the File menu. A dialog will appear allowing you to set 
the position of the map centre and the field of view. Press OK to create the map - a 
new window will appear and the default map settings will be loaded. The time and 
date will be read from the computer's clock.

2. Click the right mouse button over the    point on a horizon map that you wish to 
appear at the centre of the area map, and select Area Map... from the menu which 
appears. A dialog will appear allowing you to alter the position of the map centre and 
to set the desired field of view. Press OK to create the map. A new area map window 
will appear and the default map settings will be loaded. The time, date, and 
observation location details will be copied from the horizon map.

Once the map has been created you may wish to alter the location of the observer, or the 
date and time for which the map is drawn:

Setting the Date and Time of Observation 
Setting the Location of the Observer
See also:
Saving the Map Settings



Displaying Objects on the Area Map

A wide variety of objects can be displayed on an area map. These include:

Stars
Planets
Comets
Deep sky objects (galaxies, star clusters, and nebulae)
Constellation boundaries, figures, and names
A grid of right ascension and declination lines

The objects which appear on the map are controlled in two ways:

1. The items on the Options menu set the display options for each type of object. For 
example, the Star Labels... item controls the way in which stars are labelled; the 
Comets... item allows the user to select which comets will be displayed. To get 
specific help on these options, select the item and then press F1.

2. The Show... item on the View menu (and the equivalent buttons on the tool bar) 
allows the user to select which items are shown on the map. A huge quantity of 
information is available, and having it all displayed at once would be very confusing. 
This menu item provides a rapid way to select exactly the desired items.

Shortcut:        



Saving the Area Map Settings

When all the area map options have been set up to your satisfaction they can be saved for 
use as the default settings for all subsequent area maps. To do this:

1. From the File menu select Save Defaults.... A dialog box will appear asking for 
confirmation of the operation.

2. Click on the Yes button, or just press Enter. The current map settings will then be 
saved.



Searching for Objects on an Area Map

To search for specific objects on an area map use the items on the Search menu.

See also:
Searching for a Planet
Searching for a Constellation
Searching for a Star by Proper Name
Searching for a Star by Bayer Letter
Searching for a Star by Flamsteed Number
Searching for a Star by SAO Number
Searching for a Deep Sky Object by Popular Name
Searching for a Deep Sky Object by Messier Number
Searching for a Deep Sky Object by RNGC Number
Searching for a Comet



Displaying Pictures

One of the most exciting features of SkyMap is its ability to display photographic images.    
You can build up your own collection of pictures which, together with the maps, can really 
bring the sky to "life". A picture collection is also a good way to spend a cloudy night - here 
in England there are a lot of cloudy nights...
In order to display pictures, you really need a "SuperVGA" display capable of displaying 256
or more colours at once.    You can display pictures on a standard 16-colour VGA display, but
the results will probably be pretty horrible!
For more information, refer to the following topics:

Picture Formats
Displaying Pictures Manually
Displaying Pictures Automatically
Obtaining Picture Files



Picture Formats

SkyMap can currently display picture files in the following formats:

1. GIF files.    GIF is probably the most popular of all image formats currently in use.    
The format was specifically devised to enable pictures to be easily transferred 
between different types of computer, and there are literally tens of thousands on 
pictures in GIF format available.    SkyMap will display files in either GIF87a or GIF89a 
format, and can handle both interlaced and non-interlaced images.    The only 
restriction is that only the first image in a file can currently be displayed.    GIF files for
the PC normally have an extension of ".GIF".

2. Windows "Bitmap" files.    These are "device independent bitmap" files created for use
with Microsoft Windows.    They normally have an extension of ".BMP" (for 
uncompressed images) or ".RLE" (for compressed images).

3. NASA Planetary Data Systems (PDS) format. This is the file format used by NASA for 
pictures from spacecraft such as Voyager and Viking. The images normally have a 
resolution of 800x800 pixels, in 256 grey scales. Due to the large size of the files, CD-
ROM is the primary distribution medium for these images. There are three variants of 
the image format in common use:
Uncompressed full-resolution images, which normally have an extension of ".IMG".
Compressed full-resolution images, with an extension of ".IMQ".
Uncompressed "browse" images. These are uncompressed images containing only 
1/16th of the pixels of the full images, and are intended for rapid viewing. They 
normally have an extension of ".IBG".



Displaying Pictures Manually

From the File menu, choose the Open... item.    A standard file selector will be displayed, 
letting you select a file from any available drive or directory.    Pressing the OK button will 
create a new window in which the image will be displayed.



Displaying Pictures Automatically

SkyMap has the ability to load and display pictures of certain object automatically.    This 
can be done for all RNGC objects, as well as the planets, Moon, and Sun, and comets.    In 
order to use this feature of the program, carry out the following steps:

1. Find a nice picture of the required object in any supported image format.    You can 
use the "manual" method described above to look through pictures until you find one 
you would like to have as a "standard" picture for that particular object.

2. Copy the picture to the image directory specified in the Global Preferences Dialog , 
and rename the file to "OBJECT.EXT", where "OBJECT" is the name of the object, and 
".EXT" is the "standard" extension for the image format - ".GIF" for GIF files and 
".BMP" for bitmap files.
For planets, the name used should be one of the following:

SUN
MOON
MERCURY
VENUS
MARS
JUPITER
SATURN
URANUS
NEPTUNE
PLUTO

For Messier objects, the name should be "M" followed by the Messier number; "M32", 
for example.

For other RNGC objects, the name should be "NGC" followed by the RNGC catalogue 
number; "NGC1530A", for example.
For a comet, the file can be called anything you wish, but it must still be in the image 
file directory. Edit the details of the comet using the Comet Selection Dialog and 
enter the file name in the Comet Orbit Dialog.

3. Now, if you draw a map and click the right mouse button over an object for which a 
picture has been stored, you should find that a Picture of <object>... item appears 
on the resulting pop-up menu.    Selecting this item will display the picture in a new 
window.

Notes:

When you click on a object, SkyMap will first of all look for a file with a ".GIF" extension, 
and then for a file with a ".BMP" extension.    If files with both extensions are present, the 
GIF file will be displayed.



Obtaining Picture Files

There are many sources from which picture files (particularly GIF images) suitable for use 
with SkyMap can be obtained.    Some of these are:

1.    Commercial information services such as CompuServe.    An especially good source are 
the CompuServe "Astronomy" and "Space" forums (type "GO ASTROFORUM" or "GO SPACE"
from any prompt), which currently has more than 1000 astronomy and space-related GIF 
files available.
2.    Bulletin board systems, of which there are a vast and ever-changing number.    Some of 
these specialise in astronomy and carry a large number of GIF images.
3.    Public domain and shareware software libraries.
4.    If you have access to it, perhaps the best source of all are the vast resources of the 
Internet - a world-wide computer network.    Take a look, for example at the machine 
"explorer.arc.nasa.gov" via anonymous FTP.
5.    Finally, if you get really stuck,    a collection of GIF images is available as an option for 
registered used of SkyMap. Refer to the registration form for details.




